Welcome to the wonderful world of EXCEL!

You can use the same copy, paste, cut shortcut keys that you use in Microsoft Word in EXCEL, or mouse right click.
e Contol-x: cut
e Control-c: copy
e Control-p: paste

When dealing with data:
o Always double check your numbers after you enter the data.
e If you see a value that looks really weird, try to see if there was a mistake or if there is a reason for an extremely
high or low value (so if you see a caterpillar value that looks ‘off” ask the person whose caterpillar it is.)
o Keep one copy of your raw data untouched, copy the values to another worksheet and work with the data there.

Functions: in EXCEL anytime you type ‘=’ into a cell then EXCEL expects a function or formula to follow. EXCEL can
calculate hundreds of formulas/function. To search for a specific function (or browse them all for fun), click on the
formula tab at the top of your screen.

A few common functions:
e To calculate a column or row mean:
o =average(highlight row or column that you want to average)
o Example: To calculate the average of all the values A1 — A25, =average(A1:A25)
To calculate the sum of all values: =sum(A1:A21)
To count all the values (i.e. determine sample size): =count(A1:A25)
To calculate standard deviation =stdev.s (range of values)
To calculate a square root: =sqrt(value)

1. Copy the raw data into another worksheet (this way if you inadvertently delete or change a data value, you still
have a clean copy of your data).

Sort the data based on treatment type.

Optional: Cut and paste the data into separate treatment columns.

4. Calculate the average and standard deviation for each treatment group.
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1 Ip Treatment Cantrol Fertilizer (mass day10 grams) — . . N

R oo e 0es and =stdevs(average(C2:C22) to
4lcontrol o MR calcuate sample standard deviation
6 Control 0.07| 0.017

: 7 control 0.022 0.09 and average.

6 8 Control 0.051 0.09

7 10 Control 0.12 0.126

8 14 Control 0.0423 0.059

9 15 Control 0027 o007 Drag these formulas under the

10 17 Control 0.023 0.079 “1: 7

o 1o contral o T fertilizer column to automatically

12 22 Control 0.112 0.07

13 23 Control 0.062 0.17
14 26 Control 0.01 0.065
15 27 Control 0.078 0.075
16 30 Control 0.067 0.098
1
1
1

calculate those values. /

31 Control 0.01 0.08
32 Control 0.03] 0.086
33 Control 0.07| 0.102
20 34 Control 0.072 0.068
21 35 Control 0.027 0.1
38 Control 0.029

24 average

0.053704762
25 stdev:

EXCEL does not have a standard error function. So you’ll have to calculate standard deviation and then use that to
calculate standard error (standard error = standard deviation / square root of the sample size).



Making beautiful bar charts in EXCEL

o Please note that the numbers used in this handout are from a previous class, so your numbers will be different.
These instructions are for Microsoft Office 365 using a PC.
1. Sort your data so you can easily calculate the appropriate averages (data tab, highlight data, sort by treatment).
2. Calculate the average, standard deviation, and sample size for each category. 1 like to setup the summary
statistics in a ‘table’ that | make myself.
c27 ¥ X « Je  =c2s/sqrt(c2s)
A B C D E F
11D Treatment Control Fertilizer (mass day10 gram
2 3 Control 0.0585 0.063 —
3 4 Control 0.102 0.123
4 6 Control 0.07 0.017
5 7 Control 0.022 0.09
6 8 Control 0.051 0.09
7 10 Control 0.12 0.126
8 14 Control 0.0423 0.059
9 15 Control 0.027 0.075
10 17 Control 0.023 0.079
11 19 Control 0.045 0.1
12 22 Control 0112 007 > Raw data
13 23 Control 0.062 0.17
14 26 Control 0.01 0.065
15 27 Control 0.078 0.075
16 30 Control 0.067 0.098
17 31 Control 0.01 0.08
18 32 Control 0.03 0.086
19 33 Control 0.07 0.102
20 34 Control 0.072 0.068
21 35 Control 0.027 0.1
22 38 Control 0.029 m—
24 average 0.053704762 0.0868
25 stdev: 0.031961156/ 0.030953
26 sample size 21 20 Table of summary statistics
27| standard error |= C25/sqrt( 26)
3. Calculate standard error: standard error = stdev.s(values)/sqrt(sample size)

4. Once you have done this for both treatments, then highlight the values for your bar chart. In this example, the

height of the bars will be equal to the mean values of the fertilizer and control treatment.

Click on the ‘insert’ tab at the top of the screen.

6. In the ‘charts section’ in the middle, click on ‘columns’. Select a 2D column. The point of having a figure is to
visually describe your data. 3D graphics don’t help. Ridiculous colors don’t help. Patterns don’t help. Weird
shapes don’t help. Keep it simple.
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7.

Now we need to add treatments labels. Right click on the chart. Select ‘Select data’. The ‘Select data source’ box
will appear. Click on the edit button for horizontal ‘category’ axes labels (on the right side of the ‘data source
box’). The ‘axes labels’ range box will appear. Click on the ‘select range’ icon. Select the labels. Click OK.
Click OK again. At this point the category labels will be below each bar.
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3. Highlight the treatment labels

Now we need axes labels. Click on the chart. Click on the plus sign to the right of the chart. Select ‘axis titles’
icon. Type in your axes labels on the chart. Add units where appropriate.
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Check the axes units — are they appropriate? For example, our balance only measures to 1/1000 of a gram, so you
don’t want your graph to have more than 3 decimal places along the y-axes because this would make our
measurements seem more precise than they really are. Reduce the number of decimal points in the average values
if you need to. Right click on the y-axis, select ‘Format axis’, select ‘Number’, and change the # of decimal
places.

Check the axes units — do you need to increase or decrease the major units along the axes (the numbers along the
axes)? Basically you want enough numbers to convey the scale your measure, but not so many that the axis looks
cluttered. To format an axis, right click on the axis and select ‘format axis’. The ‘format axis’ task pane appears.
You can change units under the ‘axis option’ tab. Change the ‘major units’ to ‘fixed’ instead of ‘auto’ and type in
your new unit.



11. If you can’t see the x or y-axis lines, then you need to change their color. Right click on the axis. Select “Format
axis”. Select the paint bucket icon. Select “Line”. Choose “Solid line” and then select a color.
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12. Treally don’t like gridlines (the horizontal bars across the chart area), so please delete them in my class (right
click on them so they are highlighted and hit delete.

13. Check font size. If you want to change font size/type right click on the chart and then change the font size/type. |
typically go with 12-point font, not-bolded. It depends on what size your figure will be in the final product.

14. Delete the “chart title” you do not need a chart title for your lab reports.

Hopefully you now have a chart that looks something like this!

Control Fertilizer
Treatment



15. Time to add standard error bars. You do not want to use the standard error bars automatically calculated by
EXCEL. Click on your chart. Within ‘Chart Tools’ section at the top of the screen select the ‘Design’ tab. Click
on ‘Add chart elements’ on the far left. Select “Error bars”. Select ‘More Error Bar Options’ (bottom of the list).
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16. The ‘Format Error Bars’ box will appear. Select Custom, click on ‘specify value’. The ‘custum error bar’ box
will appear. With that box, click on the select range icon under the postive error value (this is the part of the error
bar going up) and highlight the standard error values for both treatments. Repeat for the negative error value, the
numbers will be the exact same. Click OK. You may need to move the ‘format error bars’ and ‘custom error bar’
box to the side in order to highlight your standard error values.
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17. Check to make sure the standard error values you calculated in the table match the value of the bars. If not, you
may have highlighted the wrong numbers.



Hopefully you now have a graph that looks like this. TahDah! Its ready to be included in your lab report (along
with a figure caption).
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Box Plots in EXCEL

EXCEL does not have a easy , intuitive way to make boxplots. There are programs that you can download or buy,
so if you have one of those feel free to use it. Below are the steps to ‘trick” EXCEL into making a box plot.

To avoid lots of clutter and confusion, | suggest copy and pasting your raw data into a new worksheet.

1. First you need to calculate the parts of a boxplot: quartile 1, minimum, median, maximum, and quartile 3.
EXCEL functions:

e Q1I1: =quartile(raw data values, 1)  example =quartile(B2:B21, 1), the ‘1’ tells EXCEL to calculate
the first quartile.

Minimum =min(raw data values)  example =min(B2:B21)

Median =median(B2:B21)

Maximum =max(B2:B21)

Quartile 3 =(B2,B21, 3)

Put the values in a table that you make yourself, the order is important.



2. Highlight the whole table, including all labels, then select the Insert tab at the top of the screen. Under Charts
select a Line chart and choose the Line with Markers option. The results won’t look anything like a box plot.
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3. Right click on the chart, choose Select Data and click on Switch Row/Column. Select OK.
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4. Within the Chart Tools tab, select Format. Show the Format task pane by clicking on the Format selection
button in the far left corner. Right-click on the top line. Select the paint bucket in the Format task pane. Select
no line. Then the line connecting the two points will disappear. Repeat for the other four data series.
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5. Within the Chart Design tab select Add Chart Elements and add Up/Down bars.
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6. Again within the Chart Design tab select Add Chart Elements, Lines and add High-Low lines.
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7. Delete gridlines, add labels, move the legend.

Now it looks like a box plot!
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1.

3.

t-tests in EXCEL
You will need to install the Data Analysis tookpak (it is an add-in with EXCEL).

Install the data analysis toolpak: File > Options > Add-Ins > Manage Excel Add-in (Go), Analysis Toolpak (OK).
2. Select the data tab and then the data analysis icon. Select t-test, 2-sample assuming equal variances.
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i3 Data Analysis

In the Variable 1 Range, highlight all of the fertilizer values. In the Variable 2 Range, highlight all of the control
values. In the output range, highlight where you want EXCEL to put the output.
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t-Test: Two-Sample Assuming Equal Variances

Input

Variable 1 Range:
Variable 2 Range:

SAS2:5AS22
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Hypothgsized Mean Difference:
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Alpha: 0.05

Output options
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New Workbook
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4. Examine the results. Check to make the mean and the observations number are correct. EXCEL provides you with
both the one-tail and two-tail p-values. For this experiment, you use a two-tail p-value.

1 Fertilizer [Control

2 0.063| 0.0585 t-Test: Two-Sample Assuming Equal Variances

3 0.1 0.102

4 0.08 0.07] Variable 1 Variable 2
5 0.065 0.022 Mean 0.0868 0.053705
6 0.09 0.051 Variance 0.000958 0.001022
7 0.09 0.12 Observations 20 21
8 0.059] 0.0423 Pooled Variance 0.000991

9 0.075 0.027| Hypothesized Mean Difference 0

10 0.1 0.023 df

11 0.07 0.045 tStat

12 0.098 0.112 P(T<=t) one-tail 0.000863

13 0.102 0.062 t Critical one-tail 6243

14 0.068 0.01 P(T<=t) two-tail

15 0.123 0.078 t Critical two-tail 2.022691

16 0.079 0.067|

17 0.17| 0.01

18 0.086 0.03

1] o.017 0.07 _|
20 0.126 0.072

21 0.075 0.027|

22 0.029

23

24

Degrees of freedom
t-statistic

p-value

Write up your results (one sentence) with the statistics as you would in the results section of your lab report:
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